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Copyright © 2023 Xi'an NovaStar Tech Co., Ltd. All Rights Reserved. 

No part of this document may be copied, reproduced, extracted or transmitted in any form or by any 
means without the prior written consent of Xi'an NovaStar Tech Co., Ltd. 

 

Trademark 

 is a trademark of Xi'an NovaStar Tech Co., Ltd. 

 

Statement 

You are welcome to use the product of Xi'an NovaStar Tech Co., Ltd. (hereinafter referred to as 
NovaStar). This document is intended to help you understand and use the product. For accuracy and 
reliability, NovaStar may make improvements and/or changes to this document at any time and 
without notice. If you experience any problems in use or have any suggestions, please contact us via 
contact info given in document. We will do our best to solve any issues, as well as evaluate and 
implement any suggestions. 
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Change History 

Version Release Date Description 

V3.5.13 2023-05-10 Added 2 functions: 

1. Support for the VX600, VX1000 and VX400 all-in-one 

controllers 

2. Support for the H series video wall splicers (with the 

H_20xRJ45 sending card and/or H_16xRJ45+2xfiber 

sending card installed only) 

V3.5.3 2020-06-17 Fixed 2 problems: 

1. When SmartLCT is connected to the sending card that 

is not connected to the receiving card, if you adjust the 

brightness after screen configuration is done, SmartLCT 

quits unexpectedly. 

2. If the configuration file name contains English 

parenthesis, the configuration files cannot be added in 

batches. 

V3.5.2 2020-04-27 Added 2 functions: 

1. Support for the VX16s all-in-one controller 

2. Exporting screen configuration data to a JSON file 

Fixed 2 problems: 

1. If the 2055IC chip is used, the screen becomes blurred 

when users adjust Gamma, the screen has color cast 

when users exit the seam brightness adjustment function, 

and the screen brightness changes too slowly when users 

adjust the brightness. 

2. The color temperature adjustment function and the 

calibration effect cannot work at the same time. 

V3.5.1 2019-07-23 Fixed the compatibility problem with macOS 10.10.5. 

V3.5.0 2019-06-28 Added 11 functions: 

1. Recovering receiving card parameters from factory 

partition 

2. Ethernet port hot backup verification of online device 

3. Online software update 

4. Device properties 

5. Maintenance function under Help tab in the toolbar 

6. No Video Source mode on Seam Brightness 

Adjustment page 

7. Support for K16 and NovaPro UHD Jr all-in-one 
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controllers 

8. Support for HDMI 10-bit input of MCTRL R5 

9. Support for rotation backup function of MCTRL R5 

10. Support for mirror backup function of MCTRL660 PRO 

11. Chapter 6 Troubleshooting 

Deleted 2 functions: 

1. Monitoring function 

2. Reset function in the V-Sender toolbar 

Optimized 3 functions: 

1. Rotation in 90° Increments 

2. Color temperature adjustment 

3. Seam brightness adjustment 

V3.4.2 2019-01-18 Deleted the Save button on the seam brightness adjustment 

page. 

V3.4.1 2018-11-21 1. Language setting is available only on the start page. 

2. On the device properties page, deleted Position and 

changed Mapping Position to Offset. 

3. The following functions are added in V-Sender: 

− Low latency (supported by the MCTRL4K and 

MCTRL660 PRO only) 

− Working as fiber converter (supported by the 

MCTRL660 PRO only) 

− 3D function (supported by the MCTRL4K only) 

− HDR (supported by the MCTRL4K only) 

4. New cabinet connection patterns are added. 

5. In the Advanced function on the Edit page, the 

configuration files can be sent at the same time. 

6. In section 1.2 Configuration List, the supported driver 

chips are added. 

V3.4.0 2018-08-03 1. Color temperature and color gamut adjustment is added. 

2. The advanced mode of hot backup function is visualized. 

3. Batch adjustment function is added in the Device menu. 

4. The Beacon function is deleted. 

5. UI language supports only Chinese and English. 

V3.2.0 2017-11-30 1. Double seam brightness correction is added in Seam 

Brightness Adjustment. 

2. Monitoring service and platform 

3. Cabinets can rotate in 90° increments. 

4. Beacon 

5. Receiving card program and configuration information 

readback 

V3.1.0 2017-05-25 1. Test Tool is added in the Tools menu. 

2. When the MCTRL R5 is selected, a rotating bar appears 

on each of the cabinets after you add cabinets and 

connect them. 
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3. The Batch Add button is added in the tool bar. 

4. The Alignment button is added in the tool bar. 

5. Simple Mode is added to the Hot Backup function. 

6. The Factory Reset sub-menu is added in the Settings 

menu of V-Sender. 

7. Operating wizard is added to the Simple Mode of hot 

backup. 

V3.0.0 2017-01-20 First release 
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1 Introduction 

SmartLCT is the new generation of screen configuration software from NovaStar. 
Working with sending devices and receiving cards, it allows smart configuration of 
various complex LED displays, including building-block screen configuration, offline 
(online) design, seam brightness adjustment, cabinet rotation, etc. SmartLCT makes 
screen configuration much easier and further enhances user experience. 

Key features: 

 One-click replacement of receiving card 

 Online software update 

 Supports 18bit+. 

 Supports ClearView. 

 Screen configuration like building blocks 

 Image rotation in 90° increments (working with Armor series receiving cards) 

 Image rotation at any angle (working with the MCTRL R5) 

 Readback of receiving card program and configuration information 

 Seam brightness adjustment 

 The functions of video controllers can be set in V-Sender. 

 Supports cabinet brightness and chroma adjustment in batches. 

 Supports hot backup. 

 The canvas can be exported as an image. 

Operating environment: macOS 10.10 or later, Windows 7 or later 
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1.1 System Architecture 

 

1.2 Configuration List 

Name Version/Model Function Remarks 

SmartLCT V3.5.3 Operation platform Required 

Supported 

sending 

devices 

 Windows operating environment 

MCTRL300/MCTRL 

R5/MCTRL500/MCTRL600/MCTRL660 

/MCTRL700/MCTRL4K/ 

MCTRL1600/Thunderview_S1/ MCTRL660 PRO 

 macOS operating environment 

MCTRL300/MCTRL R5/ MCTRL600/MCTRL660 

/MCTRL4K/ MCTRL1600/Thunderview_S1/ 

MCTRL660 PRO 

Send input signals to 

receiving cards via 

Gigabit Ethernet 

ports. 

Optional 

Supported all-

in-one 

controllers 

 Windows operating environment 

3D HD/NovaPro HD/ NovaPro UHD Jr 

VX2/VX2U/K2U/VX4/VX4S/VX4U/K4/K4S/K4U/V

X5s/VX6s/V700/V800/V900/V900S/VX16s 

 macOS operating environment 

3D HD/NovaPro HD/ NovaPro UHD Jr/ K16 

VX2/VX2U/K2U/VX4/VX4S/VX4U/K4/K4S/K4U/V

X5s/VX6s/V700/VX16s 

Process input signals. Optional 

Supported 

receiving cards 

MRV200/MRV210/MRV220/MRV270/MRV271/M

RV275/MRV281 

MRV300/MRV308/MRV316/MRV320/MRV328/M

RV330/MRV336/MRV340/MRV350/MRV360/MRV

365/MRV366/MRV206/DH418/DH436/MRV266/A

T20/RV17 

XC100/XC150/XC200/ARN200 

Drive the LED 

display. 

Optional 
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A4/A5/A7/A8/A4s/A5s/A7s/A8s/A9s/A10s 

Supported 

driver chips 

MBI5036/SUM2017T/MBI5038/MY9862/TLC5929/

MY9163/MBI5030/DM13H/MBI5042/SM16136/MB

I5050/SM16027/SUM2018/P2510/RFT3630/SUM

2030/SUM2130/MBI5034/MBI5040/MY9268/SCL8

060/MBI5224/MBI5051/MBI5052/SM16158/MBI50

53/MBI5153/MY9373/SM16159/MBI5252/MBI515

5/MY9266/MY9366/MBI5042B/MBI5041B/MBIA04

3/MBI5043/SUM2028/MY9269/MBI5045/MBI5039

/SUM2032/MBI5152/MBI5151 

Support current gain. Optional 

1.3 Notices 
 Mac computers currently do not support MCTRL500, MCTRL700, V800, V900 or 

V900S. 

 Do not support LED display image offset adjustment of MCTRL4K when it works 
in multi-card mode. 

 The V-Sender module does not support the Thunderview_S1, VX5s, VX6s, 
MCTRL700 or VX16s. 

 Support the cabinet configuration files (rcfgx) exported from or converted by 
NovaLCT V4.6.0 or later. 

 The Mac computer and the sending device must be set with the same IP 
address and gateway when they are connected by Ethernet cable. 

 Close NovaLCT before using V-Sender to update hardware program of NovaPro 
HD. 

1.4 Software Installation 

Just like the installation of other common software, install SmartLCT by following the 
setup wizard. 

 
In case that antivirus software or firewall prompts pop up during 
the installation, please permit them because the serial driver 
may need to be installed. 

 

The installation program will update the serial driver on the 
customers' computer to the version of the driver in the 
installation package automatically if there is no serial driver or its 
version is too early. 
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2 Language Settings 

SmartLCT is available in Chinese and English. 

In the function section of the start page, click Language and select the language you 
prefer from the dialog box that appears. 
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3 Offline Operation 

3.1 User Interface 

Run SmartLCT to enter its start page. 

Figure 3-1 Start page 

 

Create an offline project to enter the screen configuration page. 
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Figure 3-2 Screen configuration page 

 

3.1.1 Function Area 

Function Area Description 

Project 
New/Open/Save/Save 
As/Export 

Allows you to create, save and export a project. 

Edit 

Batch Add 
Allows you to add multiple same cabinets at the same 
time. 

Cabinet Management 
Allows you to manage the cabinet library, including 
adding cabinet. 

Cabinet Connection Allows you to choose the cabinet connection type. 

Disconnect Removes the connection lines between cabinets. 

Hot Backup 
Backup between devices or backup between Ethernet 
ports of a device 

Send 
Sends the display configuration information to 
hardware devices. 

Help 

Test Tool 

An LED display test tool developed by NovaStar. It can 
be used for editing and testing the display window. It 
allows you to open a preview window on the desktop 
and view the result of the test. 

Serial Driver 
(available on Mac) 

Connects to device. 

User Manual User manual of SmartLCT 

About Software information 

3.1.2 Properties Area 

Properties Area Description 

Canvas View 
Set the view of cabinet, including front view and back 
view. 
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Cabinet 

Set display status and connection type of cabinet. 

 Online 

 Cabinet receiving card No. 

 Auto Connect 

Snap Include snapping to cabinet edge and snapping to grid. 

Grid 

 Grid Color: Set the color of canvas grid. 

 Grid Width: Set the grid width (unit: pixel). 

 Grid Height: Set the grid height (unit: pixel). 

Screen Name Customize the screen name. 

Disable Edit Select this option to disable any operation on cabinet. 

Color 
Set the screen brightness, Gamma and color 
temperature. Full Screen is available for online 
operation. 

Properties 
View the cabinet properties, receiving card model, device 
name, communication port, cabinet No. and offset 
position of the top-left corner of a cabinet. 

Canvas Properties 

Click a blank area of canvas and edit the canvas properties on the Canvas tab page. 
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Figure 3-3 Canvas properties 

 

Color Adjustment 

Set the screen brightness, Gamma and color temperature. Full Screen is available 
for online operation. 
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Figure 3-4 Color properties 

 

Cabinet Properties 

Click to select a cabinet. Properties of the device and the selected cabinet are 
displayed on the Properties tab page.  

You can view the cabinet properties, receiving card model, device name, 
communication port, cabinet No. and offset position of the top-left corner of a cabinet. 

Figure 3-5 Cabinet properties 

 

Note: 

Connection 1-1-4: Indicates that the sending card No. is 1, Ethernet port No. is 1, 
and the receiving card No. is 4. 
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3.1.3 Canvas 

Configure the screen by editing cabinet information in canvas. 

Icon Description Icon Description 

 
Undo 

 
Redo 

 
Select all 

 
Zoom in 

 
Delete 

 
Zoom out 

 
Group 

 
Zoom to Fit 

 
Ungroup  Display canvas in 100% 

 
Alignment 

 
Copy 

 
Offset 

 
Paste 

 
Rotate 

 
Keyboard shortcuts 

3.1.4 Loading Capacity Usage 

Note:  

If you have set the connection type to Auto Connect, the cabinets beyond the 
loading capacity of the Ethernet ports cannot be connected. If you choose to 
manually connect the cabinets, the cabinets beyond the loading capacity of the 
Ethernet ports can be connected. 

The Loading Capacity Usage section intuitively displays the usage of the loading 
capacity of Ethernet ports. 

 Blue: The loading capacity is normal. When the loading capacity of the 
connected cabinets is within that of the Ethernet ports, the progress bar shows 
blue. 

 Red: The loading capacity is beyond the limit. When the loading capacity of the 
connected cabinets exceeds that of the Ethernet ports, the progress bar shows 
red. 

 Gray: The Ethernet ports are not loading any cabinet. 

3.2 New Project 

Run SmartLCT. In the function section of the start page, click Create Offline Design 
to enter the Create a new project page. 
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Figure 3-6 New project 

 

 Project Name: Name the project and choose a save path for the project. 

 Smart Mode: Set the mode of creating a project. 

 Device: Select a video controller. 

 Cabinet Selection: Select the manufacturer and type of the cabinets. 

 Cabinet Columns/Rows: Set the columns and rows of the cabinets. 

 Source resolution: Set the maximum input resolution of the device, namely the 
maximum screen width and height that can be loaded by the device 

 Connection Type: Select the connection type of the cabinets. You can select 
Auto Connect. 

Cabinet Management 

Add or edit cabinet information. You can edit a single cabinet or a single cabinet 
group. 



SmartLCT Screen Configuration Software 

User Manual 3 Offline Operation 
 

www.novastar.tech  
12 

 

Figure 3-7 Cabinet management 

 

 Import Cabinet: Import a saved cabinet file (*.rcfgx). Batch import is available. 

 Export Cabinet: Export the configuration information of a target cabinet as a file 
(*.rcfgx). 

 Delete: Delete the selected cabinet file. You can delete multiple files. 

 Add Cabinets: Edit cabinet related information and save it as a cabinet file. 

 Add Group: Edit cabinet file. 

 Edit: Edit the corresponding cabinet information or group name. 

Figure 3-8 Adding cabinets 
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3.3 Screen Configuration 

After an offline project is created, enter the Edit page. 

3.3.1 Adding Cabinets 

Step 1 Select device type and Ethernet port type. 

Step 2 Under Edit tab, add cabinet by using any of the following methods: 

 Click Batch Add, set information of added cabinets and click OK. Move the 
cursor to canvas and click to place cabinets. 

 Click a target cabinet icon, move the cursor to canvas, click and drag left mouse 
button to place cabinet. Right click to stop adding cabinets. 

3.3.2 Cabinet Configuration 

Connecting Cabinets 

Before configuring the screen, you must connect the cabinets by using any of the 
following methods. 

Method I: Auto connect 

On the Create a new project page, after you have set the cabinet rows and columns, 
select Auto Connect and select a connection type. 

The cabinets beyond the loading capacity of a single Ethernet port cannot be connected. 

Method II: Manually connect 

 Add cabinets in the canvas and select the target cabinets. In the Cabinet 
Connection section of the tool bar, choose a cabinet connection type. If the 
loading capacity of the cabinets loaded by a single Ethernet exceeds the allowed 
loading capacity of that Ethernet port, the connection will stop. 

 Add cabinets in the canvas. Click to select the center of the target cabinet and 
move cursor to the center of the next cabinet, and so forth. 

Methods III: Connect cabinet with keyboard shortcuts 

Use the mouse to select the first cabinet. Press Shift+Up/Down/Left/Right arrow key 
at the same time to select cabinets and connect them. 

Only regular cabinets are supported. 

Grouping Cabinets 

Step 1 In the canvas, select the target cabinets and click  (or right click to choose 
Group). 

Step 2 Select the grouped cabinet. On the Properties page, set the group name, group 
color and position of grouped cabinets. 

The grouped cabinets will be edited as a whole. 
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Figure 3-9 Grouping cabinets 

 

Disconnecting Cabinets 

Select the target cabinets and click `  in the tool bar, or right click to choose 
Delete Connection. 

3.3.3 Setting Cabinet Offset 

After you have added cabinets and connected them, a dotted rectangle surrounding 
the cabinets will appear. The size of the dotted rectangle denotes the loading 
capacity of the currently connected device. 

Step 1 Click  and drag a cabinet to change its position relative to the dotted rectangle. 

Step 2 Click  to quit the edit. 
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Figure 3-10 Setting cabinet offset 

 

3.3.4 Rotating Cabinets 

When the added device supports rotation function (only the MCTRL R5 support 
cabinet rotation currently), you can rotate the cabinets to target positions. 

Step 1 Click . Click and rotate the rotation bar (or set the rotation angle) to rotate the 
cabinets to the target position. 

Step 2 Click  to quit the edit.  
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Figure 3-11 Rotating cabinets 

 

3.4 Adding Device 

Step 1 At the bottom left of the Device section, click . 

Step 2 On the displayed Add Devices dialog box, select device type, enter the number of 
the devices to be cascaded, and click Add. 

Step 3 Click OK. 
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Figure 3-12 Adding device 

 

3.5 Hot Backup 

On the Edit tab page, click  to enter its page. You can follow the guidance 
on the hot backup page. 

 Hot backup includes backup with device and backup between devices. 

 Hot backup between devices is only available for the devices with the same 
communication ports. 

3.5.1 Backup Within Device 

Step 1 Click a device in the device area, drag the device to canvas and click to place the 
device. 

Step 2 Click  on top right of device. The Ethernet ports will be backed up 
correspondingly by default, as shown in the figure below. You cannot change the 
backup. 

Step 3 (Optional) Click to select the backup Ethernet port and drag it to the target Ethernet 
port to perform backup between Ethernet ports. 
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Note: 

 When the Ethernet ports are backed up, click  at the top right of the device to 
remove the backup. 

 Click  between two Ethernet ports to delete backup. Click  at the top right 
of the device to delete the device. 

3.5.2 Backup Between Devices 

Hot backup between devices is only available for the devices with the same 
communication ports. 

Step 1 Click a device in the device area, drag the device to canvas and click to place the 
device. 

Step 2 Drag another device to the target device. Backup between the two devices will be 
done automatically. 

Step 3 (Optional) Click to select the backup Ethernet port and drag it to the target Ethernet 
port to perform Ethernet port backup between devices. 

 

Note: 

 When the backup is done, the  icon appears on the line between the two 
devices. Click this icon to switch between master and slave. 

 Click  at the top right of a device to delete the device. 

 Click  at the top right of the dashed box to remove the backup. 

 The slave device cannot be used for screen configuration. 

3.5.3 Switching Between Master and Slave Devices 

Before backup, click the toggle button on the right of a device to set it as the master 
device or backup device. 
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Table 3-1 Ethernet port description 

Icon Description Icon Description 

 

Connection of the primary 
port is not available.  

The backup port is enabled. 

 Backup device 
 

Master device 

3.6 Sending Configuration Information 

Send current configuration information to receiving card. 

Step 1 On the Edit tab page, click . 

Step 2 Click Yes in the prompt box that appears. 

Figure 3-13 Prompt box 

 

Step 3 In the Match Device dialog box that appears, select the matched online device. 
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Figure 3-14 Matching device 

 

Step 4 Click OK. 

Note: 

For cascaded devices, all the devices to which the configuration information will be 
sent to must be matched. The information will not be sent to unmatched online 
devices. 

 



SmartLCT Screen Configuration Software 

User Manual 4 Online Operation 
 

www.novastar.tech  
21 

 

4 Online Operation 

4.1 User Interface 

Run SmartLCT to enter its start page. 

Figure 4-1 Start page 

 

Create an online project to enter the screen configuration page. 
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Figure 4-2 Screen configuration page 

 

4.1.1 Function Area 

Function Area Description 

Project 
New/Open/Save/Save 
As/Export 

Allows you to create, save and export a project. 

Device 

Reconnect 
Allows you to search for and reconnect a device, 
update hardware information and save it to the current 
file. 

Refresh Reads the hardware information again. 

Seam Brightness Adjusts the seam brightness of the LED display. 

Factory Reset Resets the parameters to factory defaults. 

Brightness Adjusts brightness of the screen. 

Batch Adjusts cabinet brightness and chroma in batches. 

Edit 

Batch Add 
Allows you to add multiple same cabinets at the same 
time. 

Cabinet Management 
Allows you to manage the cabinet library, including 
adding cabinet. 

Cabinet Connection Allows you to choose the cabinet connection type. 

Disconnect Removes the connection lines between cabinets. 

Hot Backup 
Backup between devices or backup between Ethernet 
ports of a device 

Send 
Sends the display configuration information to 
hardware devices. 

Help 

Test Tool 

A LED display test tool developed by NovaStar can be 
used for editing and testing the display window. It 
allows you to open the preview window on the desktop 
and view the result of the test. 

Maintenance 

Set the reference receiving card and new receiving 
card and use the Replace function to copy the 

configuration file of reference receiving card to the new 
receiving card. 



SmartLCT Screen Configuration Software 

User Manual 4 Online Operation 
 

www.novastar.tech  
23 

 

Function Area Description 

User Manual User manual of SmartLCT 

About Software information 

4.1.2 Properties Area 

Properties Area Description 

Canvas 

View 
Set the view of cabinet, including front view and back 
view. 

Cabinet 

Set display status and connection type of cabinet. 

 Online 

 Cabinet receiving card No. 

 Auto Connect 

Snap 
Include snapping to cabinet edge and snapping to 
grid. 

Grid 

 Grid Color: Set the color of canvas grid. 

 Grid Width: Set the grid width (unit: pixel). 

 Grid Height: Set the grid height (unit: pixel). 

Screen Name Customize the screen name. 

Disable Edit Select this option to disable any operation on cabinet. 

Cabinet 
Properties 

Cabinet 
View the cabinet properties, receiving card model, 
device name, communication port, cabinet No. and 
offset position of the top-left corner of a cabinet. 

Test Pattern Select a test pattern. 

Firmware 
Program 

 Refresh, download and upgrade program version. 

− : Read back the firmware version 
information of receiving card. This is used for 
single cabinet only. 

− : Download firmware program of receiving 
card. This is used for single cabinet only. 

− : Upgrade receiving card firmware program 
for a single or multiple cabinets. 

 View and refresh serial No. 

 View module details. 

Device 
Properties 

Switch Source Switch the source of main screen. 

Input 
Resolution 

 Select input source and data bits. 

 Select a preset resolution and refresh rate of current 
input source, or customize a preset resolution and 
refresh rate. 
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Color 

 

 

Full Screen Set the screen brightness and Gamma. 

Color 
Temperature 

Adjust the color temperature. 

Display 
Function 

 Enable 18-bit Mode 

 Enable ClearView 

Calibration 
Type 

Select calibration type, including Off, Chroma 
Calibration and Brightness Calibration.  

Color Gamut 
Setting 

Set color gamut. You can select a default mode, 
including PAL and NTSC. 

Advanced 

Sending 
Mode 

Set the mode of sending the imported cabinet 
configuration file to receiving card. 

 Send at the same time 

 Don't send 

 Remind me every time 

Setting of pre-
set image 

 Choose Image (*.bmp/*.jpg/*.png) 

 Effect Settings: Set the effect of image. 

 Duration: Set the duration of startup screen image. 

 Set the usage of pre-stored image. 

Canvas Properties 

Click a blank area of canvas and edit the canvas properties on the Canvas tab page. 
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Figure 4-3 Canvas properties 

 

Color Settings 

 Set the screen brightness, Gamma and color temperature. 

 Enable 18-bit mode. 

 Enable ClearView. 

 Select calibration type, including Off, Chroma Calibration and Brightness 
Calibration. 

 Set color gamut. 
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Figure 4-4 Color settings 

 

Cabinet Properties 

Click to select a cabinet. Properties of the device and the selected cabinet are 
displayed on the Properties tab page. The MCTRL4K is taken as an example. 

 View the cabinet properties, receiving card model, device name, communication 
port, cabinet No. and offset position of the top-left corner of a cabinet. 

 Select a test pattern. 

 Refresh, download and upgrade program version. 

 Refresh serial No. 

 View module details. 
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Figure 4-5 Cabinet properties 

 

Note: 

When the connected device supports rotation function (only the MCTRL R5 support 
cabinet rotation currently), you set the rotation center and rotation angle and other 
parameters to allow the display to rotate at any angle. 

Advanced Settings 

 Send the receiving card file. 

 Set the pre-stored image. 

− Choose image. 

− Set the effect of image 

− Set the duration of startup screen image. 

− Set usage of pre-stored image. 
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Figure 4-6 Advanced settings 

 

4.1.3 Canvas 

Configure the screen by editing cabinet information in canvas. 

Icon Description Icon Description 

 
Undo 

 
Redo 

 
Select all 

 
Zoom in 

 
Delete 

 
Zoom out 

 
Group 

 
Zoom to Fit 

 
Ungroup  Display canvas in 100% 

 
Alignment 

 
Copy 
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Offset 

 
Paste 

 
Rotate 

 
Keyboard shortcuts 

4.1.4 Loading Capacity Usage 

Note:  

If you have set the connection type to Auto Connect, the cabinets beyond the 
loading capacity of the Ethernet ports cannot be connected. If you choose to 
manually connect the cabinets, the cabinets beyond the loading capacity of the 
Ethernet ports can be connected. 

The Loading Capacity Usage section intuitively displays the usage of the loading 
capacity of Ethernet ports. 

 Blue: The loading capacity is normal. When the loading capacity of the 
connected cabinets is within that of the Ethernet ports, the progress bar shows 
blue. 

 Red: The loading capacity is beyond the limit. When the loading capacity of the 
connected cabinets exceeds that of the Ethernet ports, the progress bar shows 
red. 

 Gray: The Ethernet ports are not loading any cabinet. 

4.2 New Project 

Step 1 Run SmartLCT. On the start page, click  next to Device List to refresh device list. 

Step 2 In the Function section, click Create Online Design to enter the Create a new 
project page. 
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Figure 4-7 Start page 

 

 Project Name: Name the project and choose a save path for the project. 

 Smart Mode: Set the mode of creating a project. 

 Cabinet Selection: Select the manufacturer and type of the cabinets. 

 Cabinet Columns/Rows: Set the columns and rows of the cabinets. 

 Connection Type: Select the connection type of the cabinets. You can select 
Auto Connect. 

4.3 Screen Configuration 

After an online project is created, enter the Edit page. 

4.3.1 Adding Cabinets 

Step 1 Select device type and Ethernet port type. 

Step 2 Under Edit tab, add cabinet by using any of the following methods: 

 Click Batch Add, set information of added cabinets and click OK. Move the 
cursor to canvas and click to place cabinets. 

 Click a target cabinet icon, move the cursor to canvas, click and drag left mouse 
button to place cabinet. Right click to stop adding cabinets. 
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4.3.2 Cabinet Configuration 

Connecting Cabinets 

Before configuring the screen, you must connect the cabinets by using any of the 
following methods. 

Method I: Auto connect 

On the Create a new project page, after you have set the cabinet rows and columns, 
select Auto Connect and select a connection type. 

The cabinets beyond the loading capacity of a single Ethernet port cannot be connected. 

Method II: Manually connect 

 Add cabinets in the canvas and select the target cabinets. In the Cabinet 
Connection section of the tool bar, choose a cabinet connection type. If the 
loading capacity of the cabinets loaded by a single Ethernet exceeds the allowed 
loading capacity of that Ethernet port, the connection will stop. 

 Add cabinets in the canvas. Click to select the center of the target cabinet and 
move cursor to the center of the next cabinet, and so forth. 

Methods III: Connect cabinet with keyboard shortcuts 

Use the mouse to select the first cabinet. Press Shift+Up/Down/Left/Right arrow key 
at the same time to select cabinets and connect them. 

Only regular cabinets are supported. 

Grouping Cabinets 

Step 1 In the canvas, select the target cabinets and click  (or right click to choose 
Group). 

Step 2 Select the grouped cabinet. On the Properties page, set the group name, group 
color and position of grouped cabinets. 

The grouped cabinets will be edited as a whole. 

Figure 4-8 Grouping cabinets 
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Disconnecting Cabinets 

Select the target cabinets and click `  in the tool bar, or right click to choose 
Delete Connection. 

4.3.3 Setting Cabinet Offset 

After you have added cabinets and connected them, a dotted rectangle surrounding 
the cabinets will appear. The size of the dotted rectangle denotes the loading 
capacity of the currently connected device. 

Step 1 Click  and drag a cabinet to change its position relative to the dotted rectangle. 

Step 2 Click  to quit the edit. 

Figure 4-9 Setting cabinet offset 

 

4.3.4 Rotating Cabinets 

When the added device supports rotation function, you can follow the steps below to 
rotate the cabinets. The MCTRL R5 is taken as an example. 

Step 1 Click . Click and rotate the rotation bar (or set the rotation angle) to rotate the 
cabinets to the target position. 

Step 2 Click  to quit the edit.  
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Figure 4-10 Rotating cabinets 

 

4.4 Hot Backup 

On the Edit tab page, click  to enter its page. You can follow the guidance 
on the hot backup page. 

 Hot backup includes backup with device and backup between devices. 

 Hot backup between devices is only available for the devices with the same 
communication ports. 

4.4.1 Backup Within Device 

Step 1 Click a device in the device area, drag the device to canvas and click to place the 
device. 

Step 2 Click  on top right of device. The Ethernet ports will be backed up 
correspondingly by default, as shown in the figure below. You cannot change the 
backup. 

Step 3 (Optional) Click to select the backup Ethernet port and drag it to the target Ethernet 
port to perform backup between Ethernet ports. 
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Note: 

 When the Ethernet ports are backed up, click  at the top right of the device to 
remove the backup. 

 Click  between two Ethernet ports to delete backup. Click  at the top right 
of the device to delete the device. 

4.4.2 Backup Between Devices 

Hot backup between devices is only available for the devices with the same 
communication ports. 

Step 1 Click a device in the device area, drag the device to canvas and click to place the 
device. 

Step 2 Drag another device to the target device. Backup between the two devices will be 
done automatically. 

Step 3 (Optional) Click to select the backup Ethernet port and drag it to the target Ethernet 
port to perform Ethernet port backup between devices. 

 

Note: 

 When the backup is done, the  icon appears on the line between the two 
devices. Click this icon to switch between master and slave. 

 Click  at the top right of a device to delete the device. 

 Click  at the top right of the dashed box to remove the backup. 

 The slave device cannot be used for screen configuration. 
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4.4.3 Switching Between Master and Slave Devices 

Before backup, click the toggle button on the right of a device to set it as the master 
device or backup device. 

 

Table 4-1 Ethernet port description 

Icon Description Icon Description 

 

Connection of the primary 
port is not available.  

The backup port is enabled. 

 
Backup device 

 
Master device 

4.4.4 Verification 

Verify whether the hot backup between Ethernet ports has taken effect. This function 
is supported by the MCTRL4K (DATA_MCTRL4K_V1.2.4.0 or later) and MCTRL R5 
(DATA_MCTRLR5_V1.0.3.0 or later) only. 

Step 1 After the Ethernet port backup setting is done, click Apply. 

Step 2 On the bottom left of the page, click Verify. On the displayed Please Observe LED 
Screen dialog box, click OK. 
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4.5 Seam Brightness Adjustment 

Before you begin: Configure the LED display (that is, add cabinets and connect them) 
and save the configuration to receiving card. 

4.5.1 User Interface 

 No Video Source: You can perform seam brightness adjustment even when the 
sending card has no video source. This mode supports only AXs V4.5.0.0 and 
later versions. They cannot be used with other receiving cards together. 

 Save to HW: Save seam brightness adjustment parameters to the sending 
device. 

Figure 4-11 Seam brightness adjustment page 

 

Figure 4-12 Tool bar introduction 

Tools Description 

Module mode 

Partition the added cabinet into different partitions by module. 

 

Cabinet mode Recover the partitioned cabinet to unpartitioned. 

Row & Column Select the row seams and column seams of cabinet. 
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Row Select only row seams. 

Column Select only column seams. 

Clear Effect Clear the seam effect of selected cabinet. 

Deselect Deselect the selected cabinet seam. 

Clear All Effects Clear all the cabinet seam effects. 

Show Dashed 
Box 

Show the dashed box of cabinet on the display image. 

Show number Show the cabinet No. on the display image. 

Calibration 
Effect 

Set the calibration effect to off, Chroma calibration or brightness 
calibration. 

Show Display 
Window 

Show/Hide display window. 

Screen Display 
Position 

Set the display window position to be on the main or extended 
display. 

Window Color Red/Green/Blue/White 

Screen 
Brightness 

Drag the slider or enter a number to adjust the brightness. 

Keyboard 
Shortcuts Click . A dialog box will be displayed, as shown in Figure 

4-13. 

Figure 4-13 Shortcut settings 
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Description of Border Colors 

Gray Indicates the LED is not 
selected and the 
parameter is not adjusted. 

Blue Indicates the LED is 
selected but the parameter 
is not adjusted. 

Light green Indicates the LED is not 
selected but the 
parameter is already 
adjusted. 

Dark green Indicates the LED is 
selected and the parameter 
is already adjusted. 

4.5.2 Seam Brightness Parameter Adjustment 

Step 1 On the Device tab page, click  to enter the seam brightness adjustment page. 

Step 2 Select the target seam, and the seam will turn blue. 

Step 3 (Optional) Choose precision of the adjustment. 

Step 4 Drag the slider next to Selected Area Parameter Adjustment to adjust seam 
brightness parameters, and the borders will turn green. 

Step 5 Type “admin” to access the factory area and user area settings page. 

 Save to Factory Area: Save seam brightness adjustment parameters to the 
factory area of the receiving card. These parameters will be used for 
maintenance after the cabinet is returned to factory. 

 Save to User Area: Save seam brightness adjustment parameters to the user 
area of the receiving card. These parameters will be used for on-site screen 
adjustment. 

 Load Factory Area: Restore seam brightness adjustment parameters to the 
parameters last saved in the factory area. 

 Load User Area: Restore seam brightness adjustment parameters to the 
parameters last saved in the user area. 

Step 6 Save seam brightness adjustment parameters to the sending device. 

4.6 Batch Adjustment 

This function is used to adjust the brightness and chroma of cabinets of different 
batches in order to ensure the images are displayed uniformly on LED screen.  

4.6.1 User Interface 

Before you begin: Configure the LED display and save the configuration parameters 
to hardware. 
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Table 4-2 Batch adjustment description 

Area Description 

Tool Bar 

Import: Import the batch adjustment parameter file. 

Export: Save the adjustment parameters of current batch to local 
PC. 

Screen Display: Set the window to display on the main display or 
extended display. 

Calibration Type: Choose the type of display calibration. 

Window Switch: Show/Hide the display window. 

Save: Save the batch adjustment parameters as a file. 

Save to HW: Save the batch adjustment parameters to hardware. 

Editing Area 
Edit the status of cabinets or modules (double-click on the cabinet 
to enter the module view) displayed in the area. 

Batch Editing 
Area 

Two batches are added in this area by default when you perform 
batch adjustment for the first time. 

Click  to add a batch. 

Click  to select all batches. The statuses of cabinets in each 
batch are displayed on the display window. 

Brightness 
Adjustment 
Area 

Adjust cabinet brightness parameters. 

Chroma 
Adjustment 
Area 

Adjust cabinet chroma parameters. 
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4.6.2 Procedure 

Step 1 Select a target batch. 

Step 2 In the editing area, select the target cabinets or modules, and click Add to Sample 
Area. 

Step 3 Adjust chroma and brightness.  

Step 4 Click Apply Adjustment.  

Step 5 Click Save to HW. 

Note: Each batch must have the sample area information. 

4.7 Color Gamut Settings 

Figure 4-14 Color gamut settings 

 

Introduction to UI of color gamut diagram 

Name Description 

Tool bar 
 

Enable the editing area to enter editing status. 
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 Disable the editing status of editing area. 

 
Zoom in the image in editing area. 

 
Zoom out the image in editing area. 

 
Import configuration file. 

 Export current configuration parameters as a configuration file. 

 Restore color information. 

Editing area Click and drag the enable point to set the target color gamut. 

 
Close color gamut adjustment. 

 
Save current color gamut parameters you have set. 

/  Two common video standards for TV and broadcast industries. 

Send Send color gamut parameters to user terminal. 

Save to HW Send color gamut parameters to sending device. 

4.8 Sending Configuration Information 

Step 1 In the tool bar, click . 

Step 2 In the displayed prompt box concerning saving to HW , click Save to HW. 

Step 3 In the displayed prompt box concerning successful saving to HW, click OK. 

4.9 V-Sender 

V-Sender allows you to set the status of the current device and operate the device on 
PC. 

4.9.1 Accessing V-Sender 

Method I 

On the start page, click  in the Device List section to access V-Sender, as 
shown in the figure below. 
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Method II 

In the Device section of the editing page, click  to access V-Sender, as shown 
in the figure below. 

 

4.9.2 Introduction to Tool Bar 

 

General functions: 

 Reconnect: Reconnect the device after the device went offline. 

 Refresh: Refresh the device information 

 Save: Send current device information to the hardware device and save it. 

 Update: Update the firmware version of current controller device. 

 Seft-Test: Test the display effect of the images displayed on LED screen. 

 Monitoring Threshold: Set the temperature and voltage ranges for normal 
operating of current controller device. 

Dedicated functions for different devices (Take the MCTRL660 PRO for example.) 
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 Mirror: Set the display effect of the output image. 

 Backup: Back up the system configurations of current device. 

 Restore: Restore configurations of the system, receiving card and sending card. 

4.9.3 Adding Devices 

Step 1 At the bottom of the device list, click . The Add Devices page 
appears. 

Step 2 Select the devices you want to add and click OK. 

 

4.9.4 Information 

At the bottom of the V-Sender page, the Information tab displays the port status, 
temperature and voltage alarms. 

 

The working statuses of Ethernet ports: 

Icon Description 

 
This Ethernet port is the primary port and it is connected. 

 
This Ethernet port is the backup port, but it is not connected. 

 
This Ethernet port is the backup port and it is connected, but the 

backup has not taken effect. 

 
This Ethernet port is the backup port, but it is not connected. 
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This Ethernet port is the backup port and it is connected. The backup 

has taken effect. 

4.9.5 Control 

Under the Control tab at the bottom of the V-Sender page, you can switch the input 
source type and set the screen control mode. 

 

Screen control modes: 

  (Black Out): The screen goes black and does not display images. 

  (Freeze): Freeze current image being displayed. 

  (Normal): The screen displays images normally. 

  (Test Pattern): Use different test patterns to verify the display effect of 
current screen. 

4.9.6 Template Settings 

Select a template on the Template tab below the canvas and click  to save 
current configuration parameters as a template. You can save up to 10 templates by 
default. 

Products that support this function: V800/V900/V900S/VX2/VX2U/VX4/VX4S/VX4U/ 
K2U/K4/K4S/K4U 

 

 Clicking  will save current configuration parameters to any of the templates. 

 Clicking  will delete the selected template. 
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4.9.7 Device Properties 

After you set the Input, Color and Output, clicking Apply will complete the settings. 

Option Description 

Properties Displays the device's type, communication port, ID, hardware program 

version. Change the device name and upgrade the firmware version of 

currently connected controller device. 

Input Set the type, data bits and resolution of the input source. 

Color Adjust the contrast, saturation, hue and sharpness of the displayed 

image. 

Output Mosaic: If the number of the pixels of the LED display exceeds the 

loading capacity of the device, the mosaic function is required. For 

detailed operation, see 4.9.9 Mosaic. 

Note: When Mosaic is selected, the Disable Zoom and Auo Fit functions 

under Main Screen are disabled, and the Video Source 

Synchronization option under Main Screen is hidden. 

Main Screen: Used for setting the parameters of the main screen, such 

as capture, output size, output position 

Minor Screen: Used for setting Capture parameters of the minor screen, 

such as size, position and transparency 

Video Source Synchronization: Syncs the parameters of input and 

output video sources. 

System Used for system parameter settings 

Meanings of the parameters: 

 LCD Lock: Locks the operation screen of the device. After the 

operation screen is locked, buttons on the device are disabled. 

 Smart Gray Scale: Adjusts the grayscale of the LED display. 

 Genlock: Generator locking 

 Deinterlace: Restores the interlaced video signal to progressive signal. 

 VGA Auto Adjusting: Adjusts the sampling parameters of VGA input 

signal automatically. 

 ADC Auto Calibration: Adjusts color cast, dimming and other display 

problems. 

 Low Latency: Reduce the latency of image output. (Supported by the 

MCTRL4K and MCTRL660 PRO only) 

 Fiber Converter: Convert optical signals into electric signals. 

(Supported by the MCTRL660 PRO only) 

 3D: Set 3D function parameters. (Supported by the MCTRL4K only) 

 HDR: Improve the display effect. (Supported by the MCTRL4K only) 

Audio Used for enabling and disabling audio output and adjusting audio output 

parameters 

Audio types: 

 Following Mode: Uses the audio source of HDMI. 
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 Constant Mode: Uses the audio source that is suitable to fixed audio 

connector. 

4.9.8 Picture in Picture (PIP) 

Connect a video controller which supports PIP function. Then, enter the V-Sender 
page and select the PIP tab in the canvas. 

Click the different icons in the tool bar to adjust the layout of the main screen and 
minor screen, as shown in the figure below. 

Note: Move the mouse to the canvas. When the mouse cursor changes into a double arrow, 
click and drag to change the size of the main screen or minor screen. 

 

Tool Bar Icon Description 

Cancel  Cancels the results of a previous action. 

Revert  
Restores the results of a previous action 
that was canceled. 

Zoom in  Zooms in view. 

Zoom out  Zooms out view. 

Main and Minor Screens 
Switching  Switches between main and minor screens. 

Horizontal Layout  N/C 

Vertical Layout  N/C 

In the Middle  
N/C 

Upper Left Layout  N/C 

Lower Left Layout  N/C 

Upper Right Layout  
N/C 

Lower Right Layout  N/C 
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Main Screen Settings 

You can set the zoom status of the main screen. Three options are provided: Disable 
Zoom, Customize Zoom and Auto Fit. 

 Disable Zoom: The size of input image is the same as the size of the output 
image and only the image offset position is settable. 

 Customize Zoom: Allows you to set the start position and size for Capture. The 
captured content will be displayed on the LED display. Output Size is the size of 
the main screen in the canvas. Output Position is the start position of the 
current main screen in the canvas. 

 Auto Fit: The input image is zoomed to fit the main screen automatically. This 
mode is suitable for full screen display. 

 Selecting Apply to All will apply the settings to all the input sources. 

After the settings are done, clicking Apply will send the current configuration 
information to the input source. 

Minor Screen Settings 

The size and position of the minor screen are editable. Selecting Capture allows you 
to set the size and start position of the content to be captured. The captured content 
will be displayed on the LED display. 

  

After the settings are done, clicking Apply will send the current configuration 
information to the signal source. 

Video Source Synchronization 

Video source synchronization allows you to sync the input video source with the 
output video source. 

4.9.9 Mosaic 

Before you begin: When the pixels of the output image exceeds the loading capacity 
of a single device, the mosaic function will be required. 

Step 1 Access V-Sender. On the Output tab, select Mosaic. 

Step 2 Set parameters through any of the following methods. 



SmartLCT Screen Configuration Software 

User Manual 4 Online Operation 
 

www.novastar.tech  
48 

 

 Non-Equal Division: When the loading capacities of each of the VX4S units are 
different, set the total number of pixels of the LED display, the loading area of 
current device and the start position. 

 Equal Division: When the loading capacities of each of the VX4S units are the 
same, set the total number of pixels of the LED display, the number of mosaic 
rows and columns, and the start position of the loading area of the current 
device. 

Step 3 After the parameter settings are done, click Apply to send the settings to hardware. 

  

4.10 Other Operations 

4.10.1 Hot Backup 

For the detailed operation of hot backup, see 3.5 Hot Backup. 

4.10.2 Mapping 

SmartLCT supports the Mapping function. 

Choose Edit > Mapping. The receiving card numbers and Ethernet port information 
are displayed on the cabinets of the screen. 

4.10.3 3D Function 

This function works with the independent controller that supports 3D function, the 3D 
emitter EMT200 and 3D glasses to allow users to experience 3D effects on LED 
screen. For detailed usage, see 3D Emitter EMT200 Quick Start Guide. 

Notes: 

 Only the MCTRL4K supports 3D function. 

 Using 3D function requires a 3D video source. 

 After 3D function is enabled, if you re-assign the Ethernet ports to the DVI 
sources and re-configure the screen, you must adjust the right eye start position 
of current DVI source in V-Sender. 

 When multiple devices are cascaded, if you click Apply to All, the current 
settings will be applied to all the cascaded devices. 
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Constraints 

This function cannot be enabled with any of the following functions at the same time. 

 Calibration function of bundled software 

 Low latency 

 Genlock 

Operating Procedure 

Step 1 Connect the hardware. See 3D Emitter EMT200 Quick Start Guide. 

Step 2 Run SmartLCT. 

Step 3 Enter the V-Sender page. See 4.9.1 Accessing V-Sender. 

Step 4 On the System tab page, select Enable 3D. 

Step 5 Click  to display the 3D function settings. 

Step 6 Set the video source format, eye priority, DVI mode, right eye start, and signal delay 
time. 

 Video Source Format: Includes side-by-side, top-and-bottom, and frame 
sequential. (Set the format same as that of the video source.) 

 Eye priority: Includes right eye first and left eye first. (Set the priority according 
to the 3D glasses.) 

 DVI Mode Selection 

− : The left and right eye images of each DVI source are displayed at 
the same time. 

− : DVI1 displays the left eye image and DVI2 displays the 
right eye image. When the input source is Dual DVI, you must set the DVI 
mode. When the input source is HDMI 2.0 or DP 1.2, there is no need to set 
the DVI mode. 

 Right Eye Star: When you set the video source format as side-by-side or top-
and-bottom, you must set the right eye start position. When you set it as frame 
sequential, you do not need to set the DVI mode or the right eye start position. 

 Signal Delay Time: Set this time as required to make sure that the left and right 
eye image switching of the 3D glasses is in sync with the image switching on the 
display. 

Step 7 (Optional) Click  to display the Update Firmware of Signal Emitter dialog box. 

Then, click  to select the firmware program path. At last, Click Update. 

Step 8 (Optional) If you are using a third-party 3D emitter, select Enable third-party emitter. 

Step 9 (Optional) Click Import from File to load a 3D configuration file (*.3DConfig) saved in 
PC. 

Step 10 Click Export to export current configured 3D parameters as a file (*.3DConfig) to PC. 
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Figure 4-15 3D parameter settings 

 

4.10.4 Working Mode 

This function is used to set the working mode for the connected device as sending 
card or fiber converter. 

Note: 

 Only the MCTRL660 PRO supports the fiber converter mode. 

 When multiple devices are cascaded, if you click Apply to All, the current 
settings will be applied to all the cascaded devices. 

Operating Procedure 

Step 1 Connect the hardware. See the user manual of the connected device. 

Step 2 Run SmartLCT. 

Step 3 Enter the V-Sender page. See 4.9.1 Accessing V-Sender. 

Step 4 On the System tab page, select the target working mode under Working Mode. 

4.10.5 HDR 

This function works with the MCTRL4K independent controller and the A8s receiving 
card to greatly enhance the image quality of the display, presenting images with more 
vivid colors and clearer details. 
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Note: 

 Only the MCTRL4K supports the HDR function. 

 Using the HDR function requires an HDMI 2.0 10-bit video source. 

 When multiple devices are cascaded, if you click Apply to All, the current 
settings will be applied to all the cascaded devices. 

Constrains 

This function cannot be enabled with any of the following functions at the same time. 

 Calibration function of bundled software 

 Low latency 

Operating Procedure 

Step 1 Connect the hardware. See MCTRL4K Independent Controller User Manual. 

Step 2 Run SmartLCT. 

Step 3 Enter the V-Sender page. See 4.9.1 Accessing V-Sender. 

Step 4 On the System tab page, select Enable HDR. 

Step 5 Set the HDR standard (including HDR10 and HLG) and its parameters. 
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Figure 4-16 HDR10 

 

Figure 4-17 HLG mode 

 

4.10.6 Low Latency 

This function is used to reduce the latency from input to output of the video signal. 

Note: 

 Only the MCTRL4K and MCTRL660 PRO support low latency. 

 During screen configuration, ensure that each Ethernet port loads the cabinets 
vertically, as illustrated in Figure 4-18. 

 When multiple devices are cascaded, if you click Apply to All, the current 
settings will be applied to all the cascaded devices. 
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Figure 4-18 Cabinet loading by Ethernet ports in low latency mode 
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5 Features 

5.1 Recovering Receiving Card Parameters from Factory 
Partion 

Before you begin: Run SmartLCT, add cabinets, finish screen configuration, send all 
the configuration parameters to the hardware and save them to the receiving cards. 

On the canvas, select a cabinet, right click on it, and click Recover Parameters from 
Factory Partition. 

Figure 5-1 Recovering parameters from factory partition 

 

5.2 Online Software Update 

Run SmartLCT and click  on the start page to update the software version. 



SmartLCT Screen Configuration Software 

User Manual 5 Features 
 

www.novastar.tech  
55 

 

Figure 5-2 Online update 

 

5.3 Replacing Receiving Card With One Click 

Copy the parameters of reference receiving card and send them to the new receiving 
card. The parameters include program version, configuration file and calibration 
coefficients, etc. This function is used to maintain the faulty receiving card and 
update the configuration file of receiving card. 

Step 1 Run SmartLCT and create an online project. Choose Help > Maintenance to enter 
the maintenance page. 

Step 2 Select the cabinet you want to maintain: Click and select New Receiving Card from 
the drop-down box. 

Step 3 Select a cabinet as reference cabinet. Click and select Reference Receiving Card 
from the drop-down box. 

Step 4 Click Replace. 
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5.4 Building Screens like Building Blocks 

Step 1 In the Device section, select a device and Ethernet port. 

Step 2 In the tool bar, choose Edit > Cabinet Management >  or . 

Step 3 Move the mouse to the canvas and click to add cabinets. 

Step 4 Select one or multiple cabinets and move the mouse to change the position of the 
cabinet(s). Build different shapes of screens as required. 

5.5 Rotating in 90° Increments 

Notes: 

Before you begin: Connect the receiving cards and controller that support rotation. 

Receiving card that support rotation: A4/A4s/A5/A5s/A7/A7s/A8/A8s/A9s/A10s/B4s 

Step 1 In the canvas, select the target cabinet. 

Step 2 Click  next to Rotation in 90 Increments and select a rotation angle (0°, 90°, 
180°, 270°) from the drop-down box. 
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Figure 5-3 Rotation in 90° increments 

 

5.6 Full 360° Rotation 

Before you begin: Connect the controller MCTRL R5 to SmartLCT, and the rotation 
function can be enabled. 

Rotation of a Single Cabinet 

Step 1 Click  and select the cabinets. A rotating bar appears on each of the cabinets. 

Step 2 Select any of the rotating bars and drag the mouse. The cabinet rotates around its 
rotation center. 

Step 3 (Optional) Set the rotation center and angles of rotation in the property section on the 
right. 
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Figure 5-4 Rotation  

 

Rotation of Grouped Cabinets 

Step 1 Click  and select the target cabinets. 

Step 2 Right click the cabinets and choose Group. 

Step 3 Click to select the grouped cabinets. A rotation bar appears on the rotation center of 
the grouped cabinets. 

Step 4 Click the rotation bar and drag the cabinets. The group of cabinets rotates around the 
rotation center. 

Step 5 (Optional) Set the rotation center and angles of rotation in the property section on the 
right. 
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Figure 5-5 Rotation after grouping 

 

5.7 LED Display Test 

Choose Help > Test Tool to enter the display test tool page (that is, receiving card 
test page). 

 

 Window: Set window position and size, or hide the window. 

 Pure Color: Set window color (pure color), grayscale and refresh rate. 

 Gradient: Set the gradient color and levels of the window. 

 Grid: Set grid and color and other parameters of the window. 

 Orientation: Set module size and the number of modules loaded by the 
scanning board. Detailed settings are shown in the figure below. 
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 Help: Keyboard shortcus for quick operations. 

 About: LED display solutions. See detials in the figure below. 

 

5.8 Update and Readback of Receiving Card Configuration 
Parameters 

Save receiving card parameter configuration files to the local PC. 

Step 1 In the canvas, select the target cabinet(s). 

Step 2 Right-click to select Read back parameters/Update receiving card parameters to 
read back or update local receiving card configuration parameters. 

5.9 Applying Effect to All Receiving Cards 

Apply configuration information of one receiving card to all receiving cards. The 
configuration information includes RGB, 18Bit+, ClearView, overall brightness, color 
temperature and Gamma value. 

Step 1 Select the target cabinet. 

Step 2 Right click and click Apply Effect to All. 
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5.10 Receiving Card Program Upgrade 

Before you begin: Save the upgrade package of receiving card firmware program to 
the local PC. 

Step 1 In the canvas, select the target cabinet(s) to enter the Properties tab page on the 
right. 

Step 2 Click  next to Program Version. 

Step 3 Select the path of the upgrade package to upgrade the firmware program. 

5.11 Controller Program Upgrade 

Before you begin: Save the upgrade package of the controller firmware program to 
the local PC. 

Step 1 Enter V-Sender. 

Step 2 Click Update, or select the Properties tab and click  next to Program Version. 

Step 3 On the Firmware Upgrade window that appears, click  to select the path of the 
upgrade package. 

Step 4 Click Update. 

5.12 Exporting Screen Configuration Information as Image 

The screen configuration information can be exported as an image,  

Step 1 Choose Project > Export. The Export page appears. 

Step 2 Set export parameters and information. 
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Step 3 Click Export to export the image to the local PC. 
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Figure 5-6 Cabinet connection diagram 
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Figure 5-7 Device information 

 

Note:  

When both the cabinet width and height are 104 px or greater, detailed cabinet 
information can be shown in the exported image. 
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6 Troubleshooting 

6.1 Device Went Offline 

Step 1 Run SmartLCT. The device will be reconnected automatically. 

 If the device become online, no further action required. 

 If the device is still offline, go to Step 2. 

Step 2 Check whether hardware connection is stable. 

 Unstable: Reconnect the hardware. 

 Stable: Go to Step 3. 

Step 3 On the Edit page, click the Device tab and click Reconnect. 

 If the device become online, no further action required. 

 If the device is still offline, go to Step 3. 

6.2 Redundancy Information of Hardware Configuration Not 
Read Back 

Note: 

After hot backup is set on hardware, the redundancy information will not be read back 
on the hot backup page in SmartLCT. You must set hot backup again in SmartLCT. 

For hot backup settings, see section 4.10.1 Hot Backup. 

6.3 No Cabinet Offset Information in Readback Screen 
Inormation 

Note: 

After screen is configured and cabinet offset is set in SmartLCT, SmartLCT can read 
back the screen configuration topology. If there is no cabinet offset information in the 
readback information, you must set cabinet offset in SmartLCT again. 
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For cabinet offset settings, see section 3.3.3 Setting Cabinet Offset. 

6.4 Cabinet Display Becomes Abnormal After Mapping is 
Enabled 

Note: 

After screen is configured and Mapping function enabled in SmartLCT, the cabinet 
display the image in red. That is abnormal. You must select Normal from the test 
pattern list. 

Step 1 Run SmartLCT and click Test Pattern under Edit tab. 

Step 2 Select Normal from the drop-down box. 

6.5 Unable to Connect to MCTRL660/MCTRL600 in 
SmartLCT of Mac Version 

Step 1 Check whether hardware connection is stable. 

 Unstable: Reconnect the hardware. 

 Stable: Go to Step 2. 

Step 2 On the Edit page, click the Device tab and click Reconnect. 

 If the device become online, no further action is required. 

 If the device is still offline, go to Step 3. 

Step 3 Run SmartLCT. Under the Help tab, click Serial Driver. 

Figure 6-1 Serial driver 

 

Step 4 On the displayed terminal page, enter the computer login password and close the 
page. 

Figure 6-2 Terminal page 

 

Step 5 (Optional) After you entered the password, if the driver is not found, it indicates that . 
Please close the terminal page. 
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Figure 6-3 Driver not found 

 

6.6 Some Cabients Displaying Image Abnormally After 
Cabient Configturation File Is Updated 

After the receiving card configuration files of cabinets with same size are updated 
using the same configuration file, some cabinets display the image abnormally. 

Step 1 Check whether the abnormal cabinet is a cabinet with data group exchange. 

 No: The cabinet display is normal. 

 Yes: The cabinet display is abnormal. Go to Step 2. 

Step 2 Right click the cabinet and select Update receiving card parameters from the drop-
down list to update the corresponding configuration file again. 
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